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Safety information

Always follow basic safety precautions when 
using this product to reduce risk of injury from 
fire or electric shock.

1. Read and understand all instructions in the 
documentation that comes with the printer.

2. Observe all warnings and instructions 
marked on the product.

3. Unplug this product from wall outlets before 
cleaning.

4. Do not install or use this product near water, 
or when you are wet.

5. Install the product securely on a stable 
surface.

6. Install the product in a protected location 
where no one can step on or trip over the line 
cord, and the line cord cannot be damaged.

7. If the product does not operate normally, see 
Solve a problem.

8. There are no user-serviceable parts inside. 
Refer servicing to qualified service personnel.
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1 How do I?

● Get started

● Print

● Web Services

● Work with cartridges

● Solve a problem
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2 Get started

This guide provides details about how to use the printer and how to resolve problems.

● Accessibility

● HP EcoSolutions (HP and the Environment)

● Understand the printer parts

● Use the printer control panel

● Paper basics

● Load paper

● Set up and use accessories

● Update the printer

● Open the HP printer software (Windows)

Accessibility
The printer provides a number of features that make it accessible for people with disabilities.

Visual

The HP software provided with the printer is accessible for users with visual impairments or low vision by 
using your operating system's accessibility options and features. The software also supports most assistive 
technology such as screen readers, Braille readers, and voice-to-text applications. For users who are color 
blind, colored buttons and tabs used in the HP software have simple text or icon labels that convey the 
appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed through keyboard 
commands. The HP software also supports Windows accessibility options such as StickyKeys, ToggleKeys, 
FilterKeys, and MouseKeys. The printer doors, buttons, paper trays, and paper-width guides can be operated 
by users with limited strength and reach.

Support

For more information about accessibility solutions for HP products, visit the HP Accessibility and Aging 
website (www.hp.com/accessibility).

For accessibility information for OS X, visit the Apple website at www.apple.com/accessibility.

HP EcoSolutions (HP and the Environment)
HP is committed to helping you optimize your environmental footprint and empowering you to print 
responsibly—at home or in the office.

For more detailed information about environmental guidelines that HP follows during the manufacturing 
process, see Environmental product stewardship program. For more information about HP's environmental 
initiatives, visit www.hp.com/ecosolutions.
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● Manage Power

● Quiet Mode

● Optimize Printing Supplies

Manage Power
Use Sleep Mode and Schedule Printer On/Off to conserve electricity.

Sleep mode

Power usage is reduced while in Sleep mode. After initial setup of printer, the printer will enter Sleep mode 
after a selected period of inactivity. The default time is 5 minutes.

To change the period of inactivity before the printer sleeps:

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Printer Settings , and then press OK .

3. Select Power Management , and then press OK .

4. Select Sleep Mode, and then press OK .

5. Select the desired option, and then press OK .

Schedule On and Off

Use this feature to automatically turn the printer on or off on selected days. For example, you can schedule 
the printer to turn on at 8 a.m. and turn off at 8 p.m. from Monday to Friday. In this way, you save energy 
during the night and weekends.

Use the following instructions to schedule the day and time for On and Off.

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Printer Settings , and then press OK .

3. Select Power Management , and then press OK .

4. Select Schedule On/Off, and then press OK .

5. Select the desired option, and follow the on-screen messages to set the day and time to turn the printer 
off and on.

CAUTION: Always turn the printer off properly, using either Schedule Off or  (the Power button) located 
on the front left side of the printer.

If you improperly turn the printer off, the print carriage might not return to the correct position, causing 
problems with the cartridges and print quality issues.

Never turn off the printer when cartridges are missing. HP recommends that you replace any missing 
cartridges as soon as possible to avoid print quality issues, possible extra ink usage from the remaining 
cartridges, or damage to the ink system.

Quiet Mode
Quiet Mode slows down printing to reduce overall noise without affecting print quality. It only works when 
printing on plain paper. Additionally, Quiet Mode is disabled if you are printing using the best or presentation 
print quality. To reduce printing noise, turn on Quiet Mode. To print at normal speed, turn Quiet Mode off. 
Quiet Mode is off by default.
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NOTE: Quiet Mode does not work if you print photos or envelopes.

You can create a schedule by selecting the time when the printer prints in Quiet Mode. For example, you can 
schedule the printer to be in Quiet Mode from 10 p.m. to 8 a.m. everyday.

To turn on Quiet Mode from the printer control panel

1. From the Home screen on the printer control panel, select  Setup , and then press  OK .

2. Select Printer Settings , and then press OK .

3. Select Quiet Mode , and then press OK .

4. Select On, and then press OK .

To create a schedule for Quiet Mode from the printer control panel

1. From the Home screen on the printer control panel, select  Setup , and then press  OK .

2. Select Printer Settings , and then press OK .

3. Select Quiet Mode , and then press OK .

4. Select Schedule, and then press OK .

5. Set the start time of the schedule.

To change the hour, select the hour (selected by default), and then press the arrow buttons to increase 
or decrease the value.

To change the minute, press  to select the minute, and then press the arrow buttons to increase or 
decrease the value.

When you have finished setting the start time, press OK .

6. Set the end time of the schedule. See the previous step for instructions on changing the time.

When you have finished setting the end time, press OK .

To turn on Quiet Mode while the printer is printing

▲ On the printing screen, press OK next to  (Quiet Mode) to turn it on.

NOTE: Quiet Mode is turned on after a moment and is only active for the current print job.

To turn Quiet Mode on or off from the printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Quiet Mode .

3. Select On or Off .

4. Click Save Settings.

To turn Quiet Mode on or off from the printer software (OS X)

1. Open HP Utility. For more information, see HP Utility (OS X).

2. Select the printer.

3. Click Quiet Mode .
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4. Select On or Off .

5. Click Apply Now.

To turn Quiet Mode on or off from the Embedded Web Server (EWS)

1. Open the EWS. For more information, see Open the embedded web server.

2. Click the Settings tab.

3. In the Preferences section, select Quiet Mode , and then select On or Off .

4. Click Apply.

Optimize Printing Supplies
To optimize printing supplies such as ink and paper, try the following:

● Recycle used original HP cartridges through HP Planet Partners. For more information, visit 
www.hp.com/recycle.

● Optimize paper usage by printing on both sides of the paper.

● Change the print quality in the printer driver to a draft setting. The draft setting uses less ink.

● Do not clean the printhead unnecessarily. Doing so wastes ink and shortens the life of the cartridges.

Understand the printer parts
This section contains the following topics:

● Front view

● Printing supplies area

● Back view

Front view

1 Front USB port

2 Power button

3 Output tray
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4 Output tray extension

5 Input tray

6 Control panel

7 Control panel display

8 Cartridge access door

Printing supplies area

1 Printhead

2 Cartridges

NOTE: Cartridges should be kept in the printer to prevent possible print quality issues or printhead damage. 
Avoid removing supplies for extended periods of time. Do not turn the printer off when a cartridge is missing.

Back view

1 Power input

2 Rear access panel

3 Rear USB port

4 Ethernet network port
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Use the printer control panel
This section contains the following topics:

● Overview of buttons

● Change printer settings

Overview of buttons
The following provides a quick reference to the printer control panel features.

Label Name and Description

1 Home button: Returns to the Home screen from any other screen.

2 Back button: Returns to the previous screen.

3 Cancel button or Selection button: Changes according to what is displayed on the screen.

4 OK button: Confirms your selection.

5 Help button: Opens Help menu when on Home screen; displays the help for a selected menu option; or provides more 
information about current screen.

6 Wi-Fi Direct button: Displays the Wi-Fi Direct connection status and settings.

The light next to the Wi-Fi Direct button is :

● On when Wi-Fi Direct is turned on.

● Off when Wi-Fi Direct is turned off.

7 Wireless button: Displays the wireless status and settings. For more information, see Set up the printer for wireless 
communication.

The light next to the Wireless button is :

● On when the printer is connected to a wireless network.

● Blinking when the wireless feature is turned on but the printer is not connected to a wireless network.

● Off when the wireless feature is turned off.

8 Down arrow button: Select the next menu option or scroll down the screen.

9 Up arrow button: Select the previous menu option or scroll up the screen.
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Change printer settings
Use the control panel to change the printer function and settings, print reports, or get help for the printer.

TIP: If the printer is connected to a computer, you can also change the printer settings using the printer 
management tools in computer.

For more information about these tools, see Printer management tools.

To change settings for a function

The Home screen of the control panel display shows the available functions for the printer.

1. From the control panel, use the arrow buttons to select a desired option, and then press the OK button 
to confirm your selection.

2. Scroll to see the available settings. Select the setting you want to change, and then press the OK button.

3. Follow the prompts on the control panel display to change the settings.

NOTE: Press the Home button ( ) to return to the Home screen.

To change the printer settings

To change the printer settings or print reports, use the options available on the Setup Menu screen.

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Printer Settings , and then press OK .

3. Scroll to see the available settings. Select the setting you want to change, and then press the OK button.

4. Follow the prompts on the control panel display to change the settings.

NOTE: Press the Home button ( ) to return to the Home screen.

Paper basics
The printer is designed to work well with most types of office paper. It is best to test a variety of print paper 
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at 
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of 
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, 
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in 
a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

● Recommended papers for printing

● Order HP paper supplies

● Tips for selecting and using paper
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Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type 
of project you are printing.

Depending on your country/region, some of these papers might not be available.

Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP 
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them 
right off the printer. The printer supports several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 
15 cm), and 5 x 7 inches (13 x 18 cm) in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, 
displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers 
exceptional results with professional quality and durability.

● HP Advanced Photo Paper

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists 
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 
13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7 
inches and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

Business documents

● HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and 
newsletters. It is heavyweight for an impressive look and feel.

● HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

● HP Brochure Paper 180g Matte or HP Professional Paper 180 Matt

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.
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Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and 
vivid colors.

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more 
substantial than documents printed on standard multipurpose or copy paper. It is acid-free for longer 
lasting documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other 
everyday documents. It is acid-free for longer lasting documents.

Order HP paper supplies
The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are 
available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, 
and produce documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers. 
Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

Tips for selecting and using paper
For the best results, observe the following guidelines.

● Load only one type (and one size) of paper at a time into the input tray.

● Make sure the paper is loaded correctly in the input tray.

● Do not overload the input tray or the output tray.

● To prevent jams, poor print quality, and other printing problems, avoid loading the following paper in the 
input tray:

— Multipart forms

— Media that is damaged, curled, or wrinkled

— Media with cutouts or perforations

— Media that is heavily textured, embossed, or does not accept ink well

— Media that is too lightweight or stretches easily

— Media that contains staples or clips
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Load paper
To load standard-size paper

1. Pull out the input tray completely.

2. Slide the paper guides towards the edges of the tray as far as possible.

● To slide the paper-width guides, press the button on the left paper-width guide and slide the guide 
at the same time.

● To slide the paper-length guide, press the button on the paper-length guide and slide the guide at 
the same time.
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3. Insert the paper in portrait orientation and with the side to be printed facing down.

Make sure the stack of paper is aligned with the appropriate paper size lines on the front of the tray. 
Besides, make sure the stack of paper does not exceed the stack height marking on the right edge of the 
tray.

NOTE: Do not load paper while the printer is printing.

4. Adjust the paper-width guides and the paper-length guide until they touch the edge of the stack of 
paper.

5. Reinsert the input tray back into the printer.
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6. Pull out the output tray extension.

To load envelopes

NOTE:

● Do not load paper while the printer is printing.

● If you have a Tray 2, note that it supports only A4, Letter, or Legal sized plain paper.

1. Pull out the input tray completely.

2. If there is other paper in the input tray, remove the paper.

3. Slide the paper guides towards the edges of the tray as far as possible.

● To slide the paper-width guides, press the button on the left paper-width guide and slide the guide 
at the same time.

● To slide the paper-length guide, press the button on the paper-length guide and slide the guide at 
the same time.
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4. Insert the envelopes print-side down in portrait orientation according to the graphic below.

NOTE: Do not load envelopes while the printer is printing.

5. Adjust the paper-width guides until they touch the edge of the stack of envelopes.

6. Make sure the stack of envelopes does not exceed the stack height marking on the left paper-width 
guide.

7. Adjust the paper-length guide until it touches the edge of the stack of envelopes.

8. Reinsert the input tray back into the printer.
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9. Pull out the output tray extension.

To load cards and photo paper

NOTE:

● Do not load paper while the printer is printing.

● If you have a Tray 2, note that it supports only A4, Letter, or Legal sized plain paper.

1. Pull out the input tray completely.

2. If there is other paper in the input tray, remove the paper.

3. Slide the paper guides towards the edges of the tray as far as possible.

● To slide the paper-width guides, press the button on the left paper-width guide and slide the guide 
at the same time.

● To slide the paper-length guide, press the button on the paper-length guide and slide the guide at 
the same time.

ENWW Load paper 15



4. Insert the cards or photo paper print-side down in portrait orientation.

NOTE: Do not load paper while the printer is printing.

5. Adjust the paper-width guides until they touch the edge of the stack of paper.

6. Make sure the stack of paper does not exceed the stack height marking on the left paper-width guide.

7. Adjust the paper-length guide until it touches the edge of the stack of paper.

8. Reinsert the input tray back into the printer.
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9. Pull out the output tray extension.

To load legal-size paper

NOTE:

● Do not load paper while the printer is printing.

● If you have a Tray 2, note that it supports only A4, Letter, or Legal sized plain paper.

1. Pull out the input tray completely.

2. If there is other paper in the input tray, remove the paper.

3. Slide the paper guides towards the edges of the tray as far as possible.

● To slide the paper-width guides, press the button on the left paper-width guide and slide the guide 
at the same time.

● To slide the paper-length guide, press the button on the paper-length guide and slide the guide at 
the same time.
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4. Extend the input tray. To do this, press the button near the tray's front-left corner and at the same time, 
pull out the front of the tray.

5. Insert the paper in portrait orientation and with the side to be printed facing down.

Make sure the stack of paper is aligned with the appropriate paper size lines on the front of the tray. 
Besides, make sure the stack of paper does not exceed the stack height marking on the right edge of the 
tray.

NOTE: Do not load paper while the printer is printing.
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6. Adjust the paper-width guides and the paper-length guide until they touch the edge of the stack of 
paper.

7. Reinsert the input tray back into the printer.

8. Pull out the output tray extension.

To load paper in Tray 2

NOTE:  Tray 2 is available with some models of the printer. 

NOTE: Tray 2 supports only plain paper in A4, Letter, or Legal size.

To learn how to set up and use Tray 2, see Set up and use accessories.

1. Pull out Tray 2 completely from the printer.

2. Slide the paper guides towards the edges of the tray as far as possible.

● To slide the paper-width guides, press the button on the left paper-width guide and slide the guide 
at the same time.

● To slide the paper-length guide, press the button on the paper-length guide and slide the guide at 
the same time.
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3. Insert the paper in portrait orientation and with the side to be printed facing down.

Make sure the stack of paper is aligned with the appropriate paper size lines on the front of the tray. 
Besides, make sure the stack of paper does not exceed the stack height marking on the right edge of the 
tray.

NOTE: Do not load paper while the printer is printing.

4. Adjust the paper-width guides and the paper-length guide until they touch the edge of the stack of 
paper.

5. Check the Tray 2 area underneath the printer. If there is paper, remove the paper.

6. Reinsert Tray 2 into the printer.

Set up and use accessories
If you want to install and set up accessories (such as a second tray), see the following sections.

When using more than one tray, you can make use of the tray features provided to achieve a better 
experience.
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NOTE: Tray 2 is available with some models of the printer. You can purchase accessories online at 
www.hp.com .

Install and use Tray 2
To install Tray 2

1. Unpack the tray, remove the packing tapes and materials, and move the tray to the prepared location.

The surface must be sturdy and level.

2. Turn off the printer and unplug the power cord from the electrical socket.

3. Set the printer on top of the tray.

CAUTION: Be careful to keep your fingers and hands clear of the bottom of the printer.

4. Connect the power cord and turn on the printer.

Work with trays
By default, the printer draws paper from Tray 1. If Tray 1 is empty and Tray 2 is installed and contains paper, 
the printer draws paper from Tray 2.

You can change the behaviors using the following features:

● Default Tray: Set the default tray from which the printer draws paper first when paper of the same size 
is loaded in both Tray 1 and Tray 2.

● Tray Lock: Lock a tray to prevent it from accidental use; for example, when you have loaded special 
paper (such as letterhead or preprinted paper).

The printer will not use a locked tray even when the other tray is empty.

NOTE: For better experience, load only one type of paper in a tray.

NOTE: Tray 2 supports only plain paper.

To achieve this Follow these steps

Have paper loaded in both trays and use paper from one tray if 
the other tray is empty.

● Load paper in both trays. For more information, see Load 
paper.

● Turn off tray lock.

Have paper loaded in both trays and use paper from one of the 
trays first.

● Load paper of the same size in both trays.

● Set the desired tray as the default tray.

Be able to choose from plain paper and another paper type that 
you use occasionally.

NOTE: For better experience, load only one type of paper in a 
tray.

● Load special paper in main input tray and plain paper in Tray 
2.

● Lock the main input tray and set Tray 2 as the default tray.
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To change tray settings

NOTE: You can also change the tray settings from the HP printer software or EWS.

To access EWS and the printer software, see Embedded web server and Open the HP printer software 
(Windows).

1. Make sure the printer is turned on.

2. On the printer control panel, from the Home screen, select Setup , and then press OK .

3. Select Printer Settings , and then press OK .

4. Select Paper Settings , and then press OK .

5. Select Default Tray or Tray Lock, and then press OK .

6. Select the desired option, and then press OK .

To turn on automatic selection of tray or paper source (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Set Preferences under Print .

3. In the Printing preferences dialog box, click the Printing Shortcuts tab.

4. From the Paper Source drop-down list, select one of the auto selection options.

5. Click OK twice to close the dialog box and accept changes.

To turn on automatic selection of tray or paper source (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Select Automatically Select from the Source drop-down list.

4. Click Show Details to access the print options.

Update the printer
By default, if the printer is connected to a network and Web Services has been enabled, the printer 
automatically checks for updates.

To update the printer using the printer control panel

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Tools, and then press OK .

3. Select Update the Printer , and then press OK .

4. Select Check Updates, and then press OK .

To enable the printer to automatically check for updates

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Tools, and then press OK .

3. Select Update the Printer , and then press OK .
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4. Select Auto Update, and then press OK .

5. Select Automatically, and then press OK .

To update the printer using the embedded web server

1. Open the EWS.

For more information, see Embedded web server.

2. Click the Tools tab.

3. In the Printer Updates section, click Firmware Updates, and then follow the on-screen instructions.

NOTE: If a printer update is available, the printer downloads and installs the update, and then restarts. 

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the details, contact your network administrator or the 
person who set up the network.

Open the HP printer software (Windows)
After installing the HP printer software, depending on your operating system, do one of the following.

● Windows 10: From the computer desktop, click the Start button, click All apps, select HP, and then 
select the icon with the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the icon with 
the printer name.

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, 
and then select the icon with the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click the Start button, select 
All Programs, select HP, select the folder for the printer, and then select the icon with the printer name.
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3 Print

Most print settings are automatically handled by the software application. Change the settings manually only 
when you want to change print quality, print on specific types of paper, or use special features.

TIP: This printer includes HP ePrint , a free service from HP that allows you to print documents on your HP 
ePrint-enabled printer anytime, from any location, without any additional software or printer drivers.

TIP: You can use this printer to print documents and photos on your mobile device (such as a smartphone or 
tablet). For more information, visit the HP Mobile Printing website at www.hp.com/go/mobileprinting . If a 
local version of this website is not available in your country/region or language, you might be directed to the 
HP Mobile Printing site in another country/region or language.

● Print documents

● Print brochures

● Print on envelopes

● Print photos

● Print on special and custom-size paper

● Print on both sides (duplexing)

● Print from mobile device

● Print with AirPrint™

● Tips for print success

Print documents
To print documents (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options on the Printing Shortcuts tab.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.
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6. Click OK to close the Properties dialog box.

7. Click Print or OK to begin printing.

To print documents (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Specify the page properties.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

● Enter the scaling percentage.

4. Click Print.

To print documents from a USB flash drive

1. Insert a USB flash drive into the front USB port.

Wait for the files and folders in the USB flash drive to appear on the control panel display.

NOTE: The printer does not support encrypted USB flash drives.

2. From the control panel, find and select a document that you want to print. Press OK to confirm your 
selection.

You can use the filter, sort, or search feature to find a document. To use these features, select Find by 
pressing the Selection button ( ) on the bottom-left corner of the control panel.

3. From the Image Print screen, set the printing preferences as needed, such as the number of copies to 
print and the printing quality.

4. To begin printing, select Start Black Print or Start Color Print and then press OK .

Print brochures
To print brochures (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. On the File menu in your software application, click Print .

3. Make sure your printer is selected.

4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Settings , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.
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5. Select the appropriate options on the Printing Shortcuts tab.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.

6. Click OK to close the Properties dialog box.

7. Click Print or OK to begin printing.

To print brochures (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size, ensure that you have loaded the correct paper.

b. From the pop-up menu, choose Paper Type/Quality, and then choose the option that provides the 
best quality or maximum dpi.

4. Click Print.

Print on envelopes
Avoid envelopes with the following characteristics:

● Very slick finish

● Self-stick adhesives, clasps, or windows

● Thick, irregular, or curled edges

● Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation available with the 
software program you are using.

To print envelopes (Windows)

1. Load envelopes in the tray. For more information, see Load paper.

2. On the File menu in your software, click Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.
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NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options on the Printing Shortcuts tab.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.

6. Click OK to close the Properties dialog box.

7. Click Print or OK to begin printing.

To print envelopes (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Select the appropriate envelope size from the Paper Size pop-up menu.

If you do not see options on the Print dialog, click Show Details.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

4. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to Plain 
Paper.

5. Click Print.

Print photos
You can print a photo from either a computer or a USB flash drive.

NOTE: The printer does not support encrypted USB flash drives.

Do not leave unused photo paper in the input tray. The paper might start to curl, which could impair the 
quality of your printout. Photo paper should be flat before printing.

TIP: You can use this printer to print documents and photos on your mobile device (such as a smartphone or 
tablet). For more information, visit the HP Mobile Printing website at www.hp.com/go/mobileprinting . If a 
local version of this website is not available in your country/region or language, you might be directed to the 
HP Mobile Printing site in another country/region or language.

To print a photo from the computer (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.
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5. Select the appropriate options on the Printing Shortcuts tab.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.

6. Click OK to close the Properties dialog box.

7. Click Print or OK to begin printing.

NOTE:  After the printing is finished, remove unused photo paper from the input tray. Store the photo paper 
so it does not start to curl, which could reduce the quality of your printout. 

To print a photo from the computer (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Select the option that provides the best quality or maximum dpi.

● Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix option.

— Off: applies no changes to the image.

— On: automatically focuses the image; moderately adjusts image sharpness.

5. Select any other print settings you want, and then click Print.

To print photos from a USB flash drive

1. Insert a USB flash drive into the front USB port.

Wait for the files and folders in the USB flash drive to appear on the control panel display.

NOTE: The printer does not support encrypted USB flash drives.

2. From the control panel, find and select a photo that you want to print. Press OK to confirm your 
selection.

You can use the filter, sort, or search feature to find a photo. To use these features, select Find by 
pressing the Selection button ( ) on the bottom-left corner of the control panel.

3. From the Image Print screen, set the printing preferences as needed, such as the number of copies to 
print and the printing quality.

4. To begin printing, select Start Black Print or Start Color Print and then press OK .
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Print on special and custom-size paper
If your application supports custom-size paper, set the size in the application before printing the document. If 
not, set the size in the printer driver. You might need to reformat existing documents to print them correctly 
on custom-size paper.

To set up custom sizes (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Print , and then click Set Peferences.

3. Click the Paper/Quality tab.

4. On the Paper/Quality tab, click the Custom button.

5. In the Custom dialog box, click New.

Enter the name of the new custom size. Enter the dimensions of the new custom size.

6. Click Add, and then click OK.

To print on special or custom-size paper (Windows)

NOTE: Before you can print on custom-size paper, you must set up the custom size in the HP printer 
software.

1. Load the appropriate paper in the tray. For more information, see Load paper.

2. From the File menu in your software application, click Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Click the Paper/Quality tab.

6. On the Paper/Quality tab, select the custom size from the Paper Size drop-down list.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.

7. Select any other print settings that you want, and then click OK.

8. Click Print or OK to begin printing.

To print on special or custom-size paper (OS X)

Before you can print on custom-size paper, you must set up the custom size in the HP software.

1. Load the appropriate paper in the tray.

2. Create the new custom paper size.

a. In the software you want to print from, click File, and then click Print.

b. Make sure your printer is selected.
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c. Click Manage Custom Sizes in the Paper Size pop-up menu.

If you do not see options on the Print dialog, click Show Details.

d. Click +, and then select the new item in the list and type a name for the custom paper size.

e. Enter the height and width for your custom paper.

f. Click Done or OK, and then click Save.

3. Use the created custom paper size to print.

a. From the File menu in your software application, click Print.

b. Make sure your printer is selected.

c. Choose the custom paper size name you created in the Paper Size pop-up menu.

d. Select any other print settings you want, and then click Print.

Print on both sides (duplexing)
To print on both sides of the page (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options on the Printing Shortcuts tab.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.

6. Click OK to close the Properties dialog box.

7. Click Print or OK to begin printing.

To print on both sides of the page (OS X)

1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Layout from the pop-up menu.

3. Choose the type of binding you want for your two-sided pages, and then click Print.

Print from mobile device
You can use your printer to print documents and photos directly from your mobile devices such as a 
smartphone or tablet.
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● iOS: Use the Print option from the Share menu. No setup is required since iOS AirPrint is preinstalled. For 
more information about AirPrint, see Print with AirPrint™.

● Android: Download and enable the HP Print Service Plugin (supported by most Android devices) from 
the Google Play Store.

You can also use the HP All-in-One Printer Remote app to set up and use your HP printer for printing and 
sharing documents. Install it from the app store for your mobile device.

For help enabling mobile printing, visit the HP Mobile Printing website at www.hp.com/go/mobileprinting . If a 
local version of this website is not available in your country/region or language, you might be directed to the 
HP Mobile Printing website in another country/region or language.

Print with AirPrint™
Printing using Apple’s AirPrint is supported for iOS 4.2 and Mac OS X 10.7 or later. Use AirPrint to print 
wirelessly to the printer from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) 
in the following mobile applications:

● Mail

● Photos

● Safari

● Supported third-party applications, for example Evernote

To use AirPrint, ensure the following:

● The printer must be connected to the same network as your AirPrint enabled device. For more 
information about using AirPrint and about which HP products are compatible with AirPrint, visit the HP 
Mobile Printing website at www.hp.com/go/mobileprinting . If a local version of this website is not 
available in your country/region or language, you might be directed to the HP Mobile Printing site in 
another country/region or language.

● Load paper that matches the paper settings of the printer (see Load paper for more information). 
Accurately setting the paper size for the paper that is loaded, enables a mobile device to know what 
paper size it is printing.

Tips for print success
You can print your document on both sides of the paper. For more information, see Print on both sides 
(duplexing).

Ink tips

● If the print quality is not acceptable, see Printing issues for more information.

● Use Original HP cartridges.

Original HP cartridges are designed and tested with HP printers and papers to help you easily produce 
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP cartridges, go to www.hp.com/go/anticounterfeit.

● Install both the black and color cartridges correctly.
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For more information, see Replace the cartridges.

● Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

Ink level warnings and indicators provide estimates for planning purposes only.

For more information, see Check the estimated ink levels.

NOTE: When you receive a low-ink warning message, consider having a replacement cartridge 
available to avoid possible printing delays. You do not need to replace the cartridges until print quality 
becomes unacceptable.

● Always turn off the printer with  (the Power button) to allow the printer to protect the nozzles.

Paper loading tips

For more information, also see Load paper.

● Ensure the paper is loaded in the input tray properly, and set the correct media size and media type. 
Upon loading paper in input tray, you will be prompted to set the media size and media type.

● Load a stack of paper (not just one page). All the paper in the stack should be of the same size and type 
to avoid a paper jam.

● Load paper with the print-side down.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the guides do 
not bend the paper in the tray.

● Ensure that the input tray is fully inserted into the printer before you start printing.

Printer settings tips (Windows)

● To change default print settings, click Print , and then click Set Preferences in the HP printer software.

To open the HP printer software, see Open the HP printer software (Windows) for more information.

● To select the number of pages to print per sheet, on the Finishing tab of the printer driver, select the 
appropriate option from the Pages per sheet drop-down list.

● If you want to change the page orientation, on the Finishing tab of the printer driver, select the 
appropriate option from the Orientation area.

● You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the 
setting values that are appropriate for a particular kind of job, so that you can set all the options with a 
single click.

To use it, go to the Printing Shortcuts tab, select a printing shortcut, and then click OK.

To add a new printing shortcut, after making settings, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

● On the Print dialog, choose the Media & Quality (Paper Type/Quality in OS X v10.8 Mountain Lion) pop-
up menu and select the appropriate paper type and quality.
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Notes

● Original HP cartridges are designed and tested with HP printers and papers to help you easily produce 
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP cartridges, go to www.hp.com/go/anticounterfeit.

● Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a replacement cartridge 
available to avoid possible printing delays. You do not need to replace the cartridges until print quality 
becomes unacceptable.
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4 Web Services

The printer offers innovative, web-enabled solutions that can help you quickly access the Internet, obtain 
documents, and print them faster and with less hassle—and all without using a computer.

NOTE:  To use these web features, the printer must be connected to the Internet (either using an Ethernet 
cable or wireless connection). You cannot use these web features if the printer is connected using a USB cable.

This section contains the following topics:

● What are Web Services?

● Set up Web Services

● Use Web Services

● Remove Web Services

What are Web Services?
HP ePrint

● HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime, 
from any location. It's as simple as sending an email to the email address assigned to your printer when 
you enable Web Services on the printer. No special drivers or software are needed. If you can send an 
email, you can print from anywhere, using HP ePrint .

NOTE: You can sign up for an account on HP Connected (This site might not be available in all 
countries/regions.), and sign in to configure the ePrint settings.

Once you have signed up for an account on HP Connected (This site might not be available in all 
countries/regions.), you can sign in to view your HP ePrint job status, manage your HP ePrint printer 
queue, control who can use your printer's HP ePrint email address to print, and get help for HP ePrint .

Set up Web Services
Before you set up Web Services, make sure your printer is connected to the Internet using either an Ethernet 
or wireless connection.

To set up Web Services, use one of the following methods.

To set up Web Services using the printer control panel

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Web Services, and then press OK .

3. Press the OK button to accept the HP Connected Terms of Use and set up Web Services.

4. If you are prompted to allow the printer to check for updates automatically, press OK . In the Printer 
Update screen, select Automatically, and then press OK .

NOTE: When updates are available, follow the on-screen instructions to update the printer.
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To set up Web Services using the embedded web server

1. Open the EWS. For more information, see Embedded web server.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Setup , click Continue, and follow the on-screen instructions 
to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: When updates are available, they are automatically downloaded and installed, and then the 
printer restarts.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

Use Web Services
● Print with HP ePrint 

Print with HP ePrint
HP ePrint allows you to print to your HP ePrint-enabled printer anytime, from any location.

Before you can use HP ePrint , make sure the printer is connected to an active network providing Internet 
access.

To print a document using HP ePrint

1. Make sure Web Services have been set up successfully.

For more information, see Set up Web Services.

2. On the printer control panel, from the Home screen, scroll down to select HP ePrint , and then press OK . 
Find the HP ePrint email address on the screen.

3. Email your document to the printer.

a. On your computer or mobile device, open your email application.

NOTE: For information about using the email application on your computer or mobile device, see 
the documentation provided with the application.

b. Create a new email and attach the document to print.

c. Send the email to the printer email address.

The printer prints the attached document.

NOTE: Enter only the HP ePrint email address in the "To" field. Do not enter any additional email 
addresses in the other fields. The HP ePrint server does not accept email print jobs if there are multiple 
addresses in the "To" field or any address in the "Cc" field."

NOTE: The email will be printed once it is received. As with any email, there is no guarantee when or 
whether it will be received. You can check the print status on HP Connected (This site might not be 
available in all countries/regions.).
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NOTE: Documents printed with HP ePrint may appear different from the original. Style, formatting, 
and text flow may differ from the original document. For documents that need to be printed with a 
higher quality (such as legal documents), we recommend that you print from the software application 
on your computer, where you will have more control over what your printout looks like.

Remove Web Services
Use the following instructions to remove Web Services.

To remove Web Services using the printer control panel

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Web Services, and then press OK .

3. From the Web Services Settings screen, select Remove Web Services, and then press OK .
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5 Work with cartridges

This section contains the following topics:

● Information on cartridges and the printhead

● Some color ink is used even when printing with black cartridge only

● Check the estimated ink levels

● Replace the cartridges

● Order cartridges

● Store printing supplies

● Anonymous usage information storage

● Cartridge warranty information

Information on cartridges and the printhead
The following tips help maintain HP cartridges and ensure consistent print quality.

● The instructions in this user guide are for replacing cartridges, and are not intended for first time 
installation. For the first time installation, follow the instructions in the setup poster provided with the 
printer.

● When you turn the printer off, always use  (the Power button). This allows the printer to cap the 
printhead and protect it from damage.

● Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges.

● Handle cartridges carefully. Dropping, jarring, or rough handling during installation can cause temporary 
printing problems.

● If you are transporting the printer, do the following to prevent ink leaking from the printer or other 
damage from occurring to the printer:

— Make sure you turn off the printer by pressing  (the Power button). Wait until all sounds of 
internal motion stop before unplugging the printer.

— The printer must be transported sitting flat; it should not be placed on its side, back, front, or top.

CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid print quality 
issues and possible extra ink usage or damage to the ink system. Never turn off the printer when cartridges 
are missing.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove continuous 
ink system and install original HP (or compatible) cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to 
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or 
compatible) to continue printing.
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Some color ink is used even when printing with black cartridge 
only

Ink is used in a number of ways throughout the inkjet printing process. In general, ink in a cartridge is used for 
printing documents, photographs and other such materials. Some ink, however, must be used to maintain the 
health of the printhead; some ink is residual; and some ink evaporates. For more information on ink usage, 
visit www.hp.com/go/learnaboutsupplies and click HP Ink. (You might need to select your country/region 
using the Select Country button on the page.)

Check the estimated ink levels
You can check the estimated ink levels from the printer software or from the printer control panel.

To check the estimated ink levels from the printer control panel

1. From the Home screen, select Ink Information, and then press OK.

2. Select Estimated Levels (selected by default), and then press OK.

To check the estimated ink levels from the HP printer software (Windows)

1. Open the HP printer software.

2. In the printer software, from the main menu on the top, click Estimated Cartridge Levels.

To check the ink levels from the HP printer software (OS X)

1. Open HP Utility.

HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of the hard 
disk.

2. Select the HP OfficeJet Pro 8210 from the list of devices at the left of the window.

3. Click Supplies Status.

The estimated ink levels appear.

4. Click All Settings to return to the Information and Support pane.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in 
another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you receive a low-
ink alert, consider having a replacement cartridge available to avoid possible printing delays. You do not have 
to replace the cartridges until you are prompted to.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways, including in the 
initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, which 
keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after 
it is used. For more information, see www.hp.com/go/inkusage .

Replace the cartridges
If you do not already have replacement cartridges for the printer, see Order cartridges. Not all cartridges are 
available in all countries/regions.
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CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid print quality 
issues and possible extra ink usage or damage to the ink system. Never turn off the printer when cartridges 
are missing.

For information on recycling used ink supplies, see HP inkjet supplies recycling program.

To replace the cartridges

1. Make sure the printer is turned on.

2. Open the cartridge access door.

NOTE: Wait until the print carriage stops moving before proceeding.
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3. Press the front of the cartridge to release it, and then remove it from the slot.

4. Remove the new cartridge from its packaging.

5. Slide the cartridge into the empty slot until it clicks securely into the slot.

Make sure that the color on the cartridge matches the color on the slot.
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6. Repeat steps 3 through 5 for each cartridge you are replacing.

7. Close the cartridge access door.

Order cartridges
To order cartridges, go to www.hp.com . (At this time, some portions of the HP website are available in 
English only.) Ordering cartridges online is not supported in all countries/regions. However, many countries 
have information on ordering by telephone, locating a local store and printing a shopping list. In addition, you 
can visit the www.hp.com/buy/supplies page to obtain information about purchasing HP products in your 
country.

Use only the replacement cartridges that have the same cartridge number as the cartridge you are replacing. 
You can find the cartridge number in the following places:

● On the label of the cartridge you are replacing.

● On a sticker inside the printer. Open the cartridge access door to locate the sticker.

● In the embedded web server, by clicking the Tools tab, and then, under Product Information clicking Ink 
Gauge. For more information, see Embedded web server.

NOTE: The Setup cartridge that comes with the printer is not available for separate purchase.

Store printing supplies
● Keep all cartridges in the original sealed packages until they are needed.

● Cartridges can be left in the printer for extended periods of time. However, to assure optimal cartridge 
health, be sure to turn off the printer properly by pressing  (the Power button).

● Store cartridges at room temperature (15-35° C or 59-95° F).

Anonymous usage information storage
The HP cartridges used with this printer contain a memory chip that assists in the operation of the printer. In 
addition, this memory chip stores a limited set of anonymous information about the usage of the printer, 
which might include the following: the number of pages printed using the cartridge, the page coverage, 
frequency of printing, and the printing modes used.

This information helps HP design future printers to meet our customers' printing needs. The data collected 
from the cartridge memory chip does not contain information that can be used to identify a customer or user 
of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free return and recycling 
program (HP Planet Partners: www.hp.com/recycle ). The memory chips from this sampling are read and 
studied in order to improve future HP printers. HP partners who assist in recycling this cartridge might have 
access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the memory 
chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after 
you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this information inaccessible 
by turning off the memory chip's ability to collect the printer's usage information.
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To turn off the collecting usage information function

1. On the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Printer Settings , and then press OK .

3. Select Preferences , and then press OK .

4. Scroll down to select Store Anonymous Usage Information, and then press OK .

5. Select Off , and then press OK .

NOTE: You can continue to use the cartridge in the HP printer if you turn off the memory chip's ability to 
collect the printer's usage information.

Cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This 
warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or 
tampered with.

During the warranty period, the product is covered as long as the HP ink is not depleted and the end of 
warranty date has not been reached. The end of warranty date, in YYYY/MM format, can be found on the 
product.
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6 Network setup

Additional advanced settings are available from the printer's home page (embedded web server or EWS). For 
more information, see Embedded web server.

This section contains the following topics:

● Set up the printer for wireless communication

● Change network settings

● Use Wi-Fi Direct

Set up the printer for wireless communication
● Before you begin

● Set up the printer on your wireless network

● Change the connection type

● Test the wireless connection

● Turn on or off the wireless capability of the printer

NOTE: If you encounter problems connecting the printer, see Network and connection issues.

TIP: For more information about setting up and using the printer wirelessly, visit the HP Wireless Printing 
Center ( www.hp.com/go/wirelessprinting ).

Before you begin
Ensure the following:

● The printer is not connected to the network using an Ethernet cable.

● The wireless network is set up and working properly.

● The printer and the computers that use the printer are on the same network (subnet).

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and a wireless 
password.

● The wireless network name is the name of your wireless network.

● The wireless password prevents other people from connecting to your wireless network without your 
permission. Depending on the level of security required, your wireless network might use either a WPA 
passphrase or WEP key.

If you have not changed the network name or the security passkey since setting up your wireless network, 
you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security password or cannot remember this information, see the 
documentation provided with your computer or with the wireless router. If you still cannot find this 
information, contact your network administrator or the person who set up the wireless network.
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Set up the printer on your wireless network
Use the Wireless Setup Wizard from the printer control panel display to set up wireless communication.

NOTE: Before you proceed, go through the list at Before you begin.

1. From the printer control panel, press  (the Wireless button).

2. Press  (the Selection button) to select Settings.

3. Select Wireless Settings, and then press OK .

4. Select Wireless Setup Wizard, and then press OK .

5. Follow the display instructions to complete the setup.

If you are already using the printer with a different type of connection, such as a USB connection, follow the 
instructions in Change the connection type to set up the printer on your wireless network.

Change the connection type
After you have installed the HP printer software and connected the printer to your computer or to a network, 
you can use the software to change the connection type (for example, from a USB connection to a wireless 
connection).

NOTE: Connecting an Ethernet cable turns off the wireless capability of the printer.

To change from an Ethernet connection to a wireless connection (Windows)

1. Remove the Ethernet cable from the printer.

2. Open the printer software after the installation.

Run the Wireless Setup Wizard to make the wireless connection. For more information, see Set up the 
printer on your wireless network.

To change from a USB connection to a wireless network (Windows)

Before you proceed, go through the list at Before you begin.

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Tools.

3. Click Device Setup & Software.

4. Select Convert a USB connected printer to wireless. Follow the onscreen instructions.

To change from a USB connection to a wireless network (OS X)

1. Connect the printer to your wireless network.

2. Use 123.hp.com to change the software connection to wireless for this printer.

 Learn more about how to change from a USB to wireless connection. Click here to go online for more 

information. At this time, this website might not be available in all languages.

To change from a wireless connection to a USB or Ethernet connection (Windows)

● Connect the USB or Ethernet cable to the printer.

44 Chapter 6   Network setup ENWW

http://123.hp.com
http://www.hp.com/embed/sfs/doc?client=IWS-eLP&lc=en&cc=us&ProductNameOID=7840166&TapasOnline=NETWORK_WIRELESS
http://www.hp.com/embed/sfs/doc?client=IWS-eLP&lc=en&cc=us&ProductNameOID=7840166&TapasOnline=NETWORK_WIRELESS


To change from a wireless connection to a USB or Ethernet connection (OS X)

Add the printer to the print queue.

1. Open System Preferences .

2. Depending on your operating system, click Printers & Scanners .

3. Select your printer in the left pane and click - at the bottom of the list. Do the same for the fax entry, if 
there is one for the current connection.

4. Open HP Utility.

HP Utility is located in the HP folder in the Applications folder at the top level of the hard disk.

5. Choose Devices > Setup New Device and follow the prompts.

Test the wireless connection
Print the wireless test report for information about the printer wireless connection. The wireless test report 
provides information about the printer status, hardware (MAC) address, and IP address. If there is a problem 
with the wireless connection or if a wireless connection attempt failed, the wireless test report also provides 
diagnostic information. If the printer is connected to a network, the test report displays details about the 
network settings.

To print the wireless test report

1. From the printer control panel,press  (the Wireless button).

2. Press  (the Selection button) to select Settings.

3. Select Print Reports, and then press OK .

4. Select Test Report, and then press OK .

Turn on or off the wireless capability of the printer
The blue Wireless light on the printer control panel is lit when the wireless capability of the printer is on.

NOTE: Connecting an Ethernet cable to the printer automatically turns off the wireless capability and the 
Wireless light.

If the printer has never been connected to a wireless network, turning on the wireless capability will trigger 
the Wireless Setup Wizard to automatically run.

1. From the printer control panel,press  (the Wireless button).

2. Press  (the Selection button) to select Settings.

3. Select Wireless Settings, and then press OK .

4. Select Wireless (selected by default) and then press OK .

5. Select On or Off, and then press OK .

Change network settings
From the printer control panel, you can set up and manage your printer' wireless connection and perform a 
variety of network management tasks. This includes viewing and changing network settings, restoring 
network defaults, and turning the wireless function on or off.
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CAUTION: Network settings are provided for your convenience. However, unless you are an advanced user, 
you should not change some of these settings (such as the link speed, IP settings, default gateway, and 
firewall settings).

To print network settings

Use one of the following ways:

● From the printer control panel, press  (the Wireless button). The network status screen is displayed. 
Select Print Info by pressing the OK button to print the network configuration page.

● From the printer control panel, from the Home screen, select Setup and then press OK . Select Printer 
Reports, and then press OK . Select Network Configuration Page, and then press OK .

To set the link speed

You can change the speed at which data is transmitted over the network. The default is Automatic.

1. From the printer control panel, from the Home screen, select Network, and then press OK .

2. Select Ethernet Settings (selected by default), and then press OK .

3. Select Advanced Settings, and then press OK .

4. Scroll down to select Link Speed, and then press OK .

5. Select the appropriate option that matches your network hardware, and then press OK .

To change IP settings

The default IP setting for the IP settings is Automatic, which sets the IP settings automatically. If you are an 
advanced user and want to use different settings (such as the IP address, subnet mask, or the default 
gateway), you can change them manually.

TIP: Before setting a manual IP address, it is recommended to first connect the printer to the network using 
Automatic mode. This allows the router to configure the printer with other needed settings like subnet mask, 
default gateway and DNS address.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP address during the 
installation, your network components cannot connect with the printer.

1. From the printer control panel, from the Home screen, select Network, and then press OK .

2. Select Ethernet Settings or Wireless Settings, and then press OK .

3. Select Advanced Settings, and then press OK .

4. Select IP Settings (selected by default), and then press OK .

5. If a warning message that indicates changing the IP address removes the printer from the network 
appears, press OK to continue.

6. Automatic is selected by default. To change the settings manually, select Manual, and then press OK . 
Enter the appropriate information for the following settings:

● IP Address

● Subnet Mask

● Default Gateway

● DNS Address
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To enter the information of a setting, select the desired setting, and then press OK .

7. After entering your changes, select Apply by pressing  (the Selection).

8. Press OK .

Use Wi-Fi Direct
With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable 
device—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct

● Make sure your computer or mobile device has the necessary software.

— If you are using a computer, make sure you have installed the printer software provided with the 
printer.

If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and 
then install the printer software. Select Wireless when prompted by the printer software for a 
connection type.

— If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/global/us/en/eprint/
mobile_printing_apps.html.

● Make sure Wi-Fi Direct for your printer is turned on.

● Up to five computers and mobile devices can use the same Wi-Fi Direct connection.

● Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to 
a network using a wireless connection.

● Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet.

● Wi-Fi Direct password: If the connection method of Wi-Fi Direct on the printer is set to Automatic, the 
password will always be '12345678'. If the connection method of Wi-Fi Direct on the printer is set to 
Manual, the password will be a randomly generated 8-digit code.

To obtain the Wi-Fi Direct password of the printer, from the printer control panel, press  (the Wi-Fi 

Direct button). The Wi-Fi Direct password will be displayed on the control panel display.

To turn on Wi-Fi Direct

1. Do either of the following:

● From the printer control panel, press  (the Wi-Fi Direct button).

● From the printer control panel, from the Home screen, scroll down to select Wi-Fi Direct, and then 
press OK .

2. Press  (the Selection button) to select Settings.

3. Select Wi-Fi Direct (selected by default) and then press OK .

4. Select On and then press OK .
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To print from a wireless-capable mobile device that supports Wi-Fi Direct

Make sure you have installed the latest version of HP Print Service Plugin on your mobile device. You can 
download this plugin from the Google Play application store.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided with 
the mobile device.

3. From your mobile device, select a document from a print enabled application, and then select the option 
to print the document.

The list of available printers appears.

4. From the list of available printers, choose the Wi-Fi Direct name shown such as DIRECT-**-HP OfficeJet 
Pro XXXX (where ** are the unique characters to identify your printer and XXXX is the printer model 
located on the printer) to connect your mobile device.

If the mobile device is not automatically connected to the printer, follow the instructions on the printer 
control panel to connect to the printer. If a PIN code is displayed on the printer control panel, enter the 
PIN code on your mobile device.

When the mobile device is successfully connected to the printer, the printer starts printing.

To print from a wireless-capable mobile device that does not support Wi-Fi Direct

Make sure you have installed a compatible printing app on your mobile device. For more information, visit the 
HP Mobile Printing website at www.hp.com/go/mobileprinting . If a local version of this website is not 
available in your country/region or language, you might be directed to the HP Mobile Printing site in another 
country/region or language.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation 
provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a 
new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks 
shown such as DIRECT-**-HP OfficeJet Pro XXXX (where ** are the unique characters to identify your 
printer and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

4. Print your document.

To print from a wireless-capable computer (Windows)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with 
the computer.

NOTE: If your computer does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new 
wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown 
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such as DIRECT-**-HP OfficeJet Pro XXXX (where ** are the unique characters to identify your printer 
and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless 
network. If the printer has been installed and connected to your computer with a USB cable, follow the 
steps below to install the printer software using the Wi-Fi Direct connection.

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. Click Tools.

c. Click Device Setup & Software, and then select Connect a new printer.

NOTE: If you have previously installed the printer over USB and want to convert to Wi-Fi Direct, 
do not select the Convert a USB connected printer to wireless option.

d. When the Connection Options software screen appears, select Wireless.

e. Select your HP printer from the detected printer list.

f. Follow the onscreen instructions.

5. Print your document.

To print from a wireless-capable computer (OS X)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi on the computer.

For more information, see the documentation provided by Apple.

3. Click the Wi-Fi icon and choose the Wi-Fi Direct name, such as DIRECT-**-HP OfficeJet Pro XXXX (where 
** are the unique characters to identify your printer and XXXX is the printer model located on the 
printer).

If Wi-Fi Direct is turned on with security, enter the password when prompted.

4. Add the printer.

a. Open System Preferences .

b. Click Printers & Scanners .

c. Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed the right column 
beside the printer name), and click Add.

 Click here for online troubleshooting for Wi-Fi Direct, or for more help with setting up Wi-Fi Direct. At 

this time, this website might not be available in all languages.
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7 Printer management tools

This section contains the following topics:

● Toolbox (Windows)

● HP Utility (OS X)

● Embedded web server

● HP Web Jetadmin software

Toolbox (Windows)
The Toolbox provides maintenance information about the printer.

NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the system 
requirements. System requirements can be found in the Readme file, which is available on the HP printer 
software CD provided with your printer.

To open the Toolbox

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Print .

3. Click Maintain Your Printer.

HP Utility (OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find 
website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink 
warning message, consider having a replacement cartridge available to avoid possible printing delays. You do 
not need to replace cartridges until the print quality becomes unacceptable.

Double-click HP Utility in the HP folder in the Applications folder.

Embedded web server
When the printer is connected to a network, you can use the printer's embedded web server (EWS) to view 
status information, change settings, and manage it from your computer.

NOTE: To view or change some settings, you might need a password.

NOTE: You can open and use the embedded web server without being connected to the Internet. However, 
some features are not available.

● About cookies

● Open the embedded web server
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● Embedded web server cannot be opened

About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are 
browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have 
configured the EWS language, a cookie helps remember which language you have selected so that the next 
time you access the EWS, the pages are displayed in that language. Some cookies (such as the cookie that 
stores customer-specific preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is 
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to 
remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following features:

● Using some setup wizards

● Remembering the EWS browser language setting

● Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see 
the documentation available with your Web browser.

Open the embedded web server
You can access the embedded web server through either a network or Wi-Fi Direct.

To open the embedded web server through a network

1. Find out the IP address or hostname of the printer by pressing  (the Wireless button) on the printer 
control panel or by printing a network configuration page.

NOTE: The printer must be on a network and must have an IP address.

2. In a supported web browser on your computer, type the IP address or hostname assigned to the printer.

For example, if the IP address is 123.123.123.123, type the following address into the web browser: 
http://123.123.123.123.

To open the embedded web server through Wi-Fi Direct

1. From the printer control panel, from the Home screen, scroll down to select Wi-Fi Direct, and then press 
OK .

2. If the Wi-Fi Direct Settings shows that Wi-Fi Direct is Off , you need to turn it on.

To turn on Wi-Fi Direct

a. Press  (the Selection button) to select Settings.

b. Select Wi-Fi Direct (selected by default) and then press OK .

c. Select On and then press OK .
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3. From your wireless computer, turn wireless on, search for and connect to the Wi-Fi Direct name, for 
example: DIRECT-**-HP OfficeJet Pro XXXX (where ** are the unique characters to identify your printer 
and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

4. In a supported web browser on your computer, type the following address: http://
192.168.223.1.

Embedded web server cannot be opened
Check your network setup

● Make sure you are not using a phone cord or a crossover cable to connect the printer to the network.

● Make sure the network cable is securely connected to the printer.

● Make sure the network hub, switch, or router is turned on and working correctly.

● If the printer is connected to a wireless network, make sure the wireless connection is good by printing 
the wireless test report.

● Sometimes power cycling the router can help restore the ability to connect to the Embedded Web 
Server.

Check the computer

● Make sure the computer that you are using is connected to the same network as the printer.

Check your web browser

● Make sure the web browser meets the minimum system requirements.

● If your web browser uses any proxy settings to connect to the Internet, try turning off these settings. For 
more information, see the documentation available with your web browser.

● Make sure JavaScript and cookies are enabled in your web browser. For more information, see the 
documentation available with your web browser.

Check the printer IP address

● Make sure the printer IP address is correct.

To find out the printer IP address, from the printer control panel, press  (the Wireless button). You can 
see the printer IP address on the control panel display. If you see an IP address similar to 
169.254.xxx.xxx, try power cycle the router and the printer as this is an invalid IP address.

To obtain the IP address by printing a network configuration page: From the printer control panel, from 
the Home screen, select Setup and then press OK . Select Printer Reports, and then press OK . Select 
Network Configuration Page, and then press OK .

● Ping the printer using the IP address from the command prompt (Windows) or from Network Utility (OS 
X).

NOTE: OS X Lion and OS X Mountain Lion: Network Utility is located in the Utilities folder in the 
Applications folder at the top level of the hard disk.

OS X Mavericks: Open Finder, hold down the Option key and choose System Information from the Apple 
( ) menu. Choose Window > Network Utility.
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For example, if the IP address is 123.123.123.123, type the following at the command prompt 
(Windows):

C:\ping 123.123.123.123
Or

In Network Utility (OS X), click the Ping tab, type the 123.123.123.123 in the box, and then click Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the IP address is incorrect.

TIP: If you are using a computer running Windows, you can visit the HP online support website at 
www.support.hp.com . This website provides information and utilities that can help you correct many 
common printer problems.

HP Web Jetadmin software
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of 
networked HP devices, including printers, multifunction products, and digital senders. This single solution 
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging 
environment — ultimately increasing business productivity by helping you save time, control costs, and 
protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product features. 
Visit www.hp.com/go/webjetadmin to learn more about updates, release notes, or support documents.
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8 Solve a problem

The information in this section suggests solutions to common problems. If your printer is not operating 
correctly and these suggestions did not solve your problem, try using one of the support services listed in HP 
support to obtain assistance.

This section contains the following topics:

● Jams issues

● Printing issues

● Network and connection issues

● Printer hardware issues

● Get help from the printer control panel

● Understand printer reports

● Solve problems using Web Services

● Maintain the printer

● Restore defaults and settings

● HP support

Jams issues
What do you want to do?

Clear a paper jam

Solve paper jam issues. Use an HP online troubleshooting wizard

Instructions for clearing paper jams and resolving issues with paper or the paper feed.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing paper jams

Paper jams can occur in several locations.

CAUTION: To prevent possible damage to the printhead, clear paper jams as soon as possible.

To clear a paper jam from Tray 1

1. Pull Tray 1 out of the printer completely.
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2. Check the gap under the printer where the input tray was. Reach into the gap and remove the jammed 
paper.

3. Insert the input tray back into the printer.

To clear a paper jam from Tray 2

NOTE:  Tray 2 is available with some models of the printer. 

▲ Pull Tray 2 out of the printer completely, and then remove any jammed paper if possible. If the jam 
cannot be cleared in this way, do the following:

a. Lift the printer off Tray 2.

b. Remove any jammed paper from the bottom of the printer or from the input tray.

c. Reposition the printer on the top of the input tray.

To clear a paper jam from the print carriage area

1. Open the cartridge access door.
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2. If the print carriage is not obstructed, move the print carriage to the rightmost end, and remove the 
jammed paper with both hands.

3. If need, move the print carriage to the leftmost end, and remove any jammed or torn pieces of paper.

4. Close the cartridge access door.

To clear a paper jam from the rear of the printer

1. Turn to the rear of the printer.

2. Press the two buttons on the rear access panel and at the same time pull the panel to open it.

3. Remove any jammed paper.
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4. Press the two buttons on the paper path cover, and pull the cover out of the printer completely.

5. Remove any jammed paper.

6. Insert the paper path cover back into the printer.

7. Close the rear access panel.

8. Turn to the front of the printer.

Clear a print carriage jam

Resolve a print carriage jam. Use an HP online troubleshooting wizard

If something is blocking the print carriage or it does not move easily, get step-by-step instructions.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing a print carriage jams

To clear a print carriage jam

▲ Remove any objects, such as paper, that are blocking the print carriage.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when 
removing jammed paper from inside the printer.

Learn how to avoid paper jams
To help avoid paper jams, follow these guidelines.

● Remove printed papers from the output tray frequently.

● Make sure that you are printing with paper that is not wrinkled, folded, or damaged.
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● Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.

● Do not use paper that is too thick or too thin for the printer.

● Make sure that the trays are loaded correctly and are not too full. For more information, see Load paper.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the 
input tray must be the same size and type.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the paper-width 
guides do not bend the paper in the input tray.

● Use paper types that are recommended for the printer.

● If the printer is about to run out of paper, allow the printer to run out of paper first, and then add paper. 
Do not load paper when the printer is printing.

● When removing the input tray, it is recommended to remove the tray completely from the printer to 
make sure no paper is stuck at the rear of the tray.

Solve paper-feed problems
What kind of problem are you having?

● Paper is not picked up from a tray   

— Make sure paper is loaded in the tray. For more information, see Load paper. Fan the paper before 
loading.

— Make sure the paper-width guides are set to the correct markings in the tray for the paper size you 
are loading. Also make sure the paper guides are snug, but not tight, against the stack.

— Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the 
input tray, and does not exceed the stack height indicated by one or more label on the side or 
paper-width guide of the input tray.

— Make sure paper in the tray is not curled. Uncurl paper by bending it in the opposite direction of the 
curl.

● Pages are skewing   

— Make sure the paper loaded in the input tray is aligned to the paper-width guides. If needed, pull 
out the input tray from the printer and reload the paper correctly, making sure that the paper 
guides are aligned correctly.

— Load paper into the printer only when it is not printing.

● Multiple pages are being picked up  

— Make sure the paper-width guides are set to the correct markings in the tray for the paper size you 
are loading. Also make sure the paper-width guides are snug, but not tight, against the stack.

— Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the 
input tray, and does not exceed the stack height indicated by one or more label on the side or 
paper-width guide of the input tray.

— Make sure the tray is not overloaded with paper.

— Use HP paper for optimum performance and efficiency.
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Printing issues
What do you want to do?

Fix problems with page not printing (unable to print)

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operating system. 

Troubleshoot problems with 
print jobs not printing.

Use an HP online troubleshooting wizard

Get step-by-step instructions if the printer is not responding or printing.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for unable to print issues

To resolve print issues (Windows)

NOTE: Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to 
print, try the following in order:

1. Check for error messages from the printer control panel and resolve them by following the onscreen 
instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the USB cable. If 
your computer is connected to the printer with a wireless connection, confirm that the connection is 
working.

3. Verify that the printer is not paused or offline.

To verify that the printer is not paused or offline

a. Depending on your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, click Windows System, click 
Control Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select See 
what’s printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer 
Offline.

d. If you made any changes, try to print again.
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4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending on your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, click Windows System, click 
Control Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending on your operating system, do one of the following:

Windows 10

i. From the Windows Start menu, click All apps, and then click Windows System.

ii. Click Control Panel, click System and Security, and then click Administrative Tools.

iii. Double-click Services.

iv. Right-click the Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click Start, and then click OK.

Windows 8.1 and Windows 8

i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the 
Settings icon.

ii. Click or tap Control Panel, and then click or tap System and Security.

iii. Click or tap Administrative Tools, and then double-click or double-tap Services.

iv. Right-click or touch and hold Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then click or 
tap OK.
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Windows 7

i. From the Windows Start menu, click Control Panel, System and Security, and then 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista

i. From the Windows Start menu, click Control Panel, System and Maintenance, 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler service, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows XP

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.

iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

To clear the print queue

a. Depending on your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, click Windows System, click 
Control Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.
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● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to 
confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the 
computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

To check the power connection and reset the printer

1. Make sure the power cord is firmly connected to the printer.

2. Look at the Power button located on the printer. If it is not lit, the printer is turned off. Press the Power 
button to turn on the printer.

NOTE: If the printer is not receiving electrical power, connect it to another power outlet.

3. With the printer turned on, disconnect the power cord from the side of the printer.

4. Unplug the power cord from the wall outlet.

5. Wait at least 15 seconds.

6. Plug the power cord back into the wall outlet.

7. Reconnect the power cord to the side of the printer.

8. If the printer does not turn on by itself, press the Power button to turn on the printer.

9. Try using the printer again.

To resolve print issues (OS X)

1. Check for error messages and resolve.

2. Disconnect and reconnect the USB cable.

3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

a. In System Preferences, click Print & Fax.

b. Click the Open Print Queue button.

c. Click a print job to select it.

Use the following buttons to manage the print job:

● Delete: Cancel the selected print job.

● Hold: Pause the selected print job.
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● Resume: Continue a paused print job.

● Pause Printer: Pause all print jobs in the print queue.

d. If you made any changes, try to print again.

4. Restart the computer.

Fix print quality issues

Step-by-step instructions for resolving most print quality issues. Troubleshoot print quality issues online

Read general instructions in the Help for resolving print quality issues

NOTE: To avoid print quality problems, always turn the printer off using the Power button, and wait until the 
Power button light goes out before you pull the plug or turn off a power strip. This allows the printer to move 
the cartridges to a capped position, where they are protected from drying out.

To improve print quality

1. Make sure you are using original HP cartridges.

2. Make sure you are using an appropriate paper type.

Always make sure the paper you are printing on is flat and is not damaged, curled, or wrinkled. For more 
information, see Tips for selecting and using paper.

For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For 
more information, see Paper basics.

For best results when printing images, use HP Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool, 
dry place.

When you are ready to print, remove only the paper you plan to use immediately. When you have 
finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper from 
curling.

3. Make sure you have selected the appropriate paper type and print resolution in the software print 
settings.

NOTE: Selecting a higher print quality can result in a printout with higher definition but could use more 
ink and take longer to print.

4. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see 
Check the estimated ink levels. If the cartridges are low on ink, consider replacing them.

5. Print a diagnostics page if the cartridges are not low on ink.

To do this, you must:

● Load Letter, A4, or Legal unused plain white paper into the paper tray.

● Print out the page either using the printer software or the control panel.
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To print a diagnostics page from the printer software (Windows)

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. In the printer software, click Print > Maintain Your Printer to access the printer toolbox.

c. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.

To print a diagnostics page from the printer software (OS X)

a. Open HP Utility.

NOTE: HP Utility is located in the HP folder in the Applications folder at the top level of the hard 
disk.

b. Select your printer from the Devices list.

c. Click Test Page.

d. Click the Print Test Page button, and follow the onscreen instructions.

To print a diagnostics page from the printer control panel

a. On the printer control panel, from the Home screen, select Setup , and then press OK .

b. Select Printer Reports, and then press OK .

c. Select Print Quality Report, and then press OK .

6. If the diagnostic page shows steaks or missing portions of the color and black boxes, perform auto-
cleaning of the cartridges or printhead.

To do this, you must:

● Load Letter, A4, or Legal unused plain white paper into the paper tray.

● Perform the cleaning either using the printer software or the control panel.

To clean the cartridges or printhead from the printer software (Windows)

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. In the printer software, click Print > Maintain Your Printer to access the printer toolbox.

c. From the Device Services tab, click the option to clean, and then follow the onscreen instructions.

To clean the cartridges or printhead from the printer software (OS X)

a. Open HP Utility.

NOTE: HP Utility is located in the HP folder in the Applications folder at the top level of the hard 
disk.

b. Select your printer from the Devices list.

c. Click Clean Printheads.

d. Click Clean, and follow the onscreen instructions.
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To clean the cartridges or printhead from the printer control panel

a. On the printer control panel, from the Home screen, select Setup , and then press OK .

b. Select Tools, and then press OK .

c. Select the option to clean, press OK , then follow the onscreen instructions.

If cleaning the cartridges or printhead does not solve the problem, contact HP support. Go to 
www.support.hp.com . This website provides information and utilities that can help you correct many 
common printer problems. If prompted, select your country/region, and then click All HP Contacts for 
information on calling for technical support.

CAUTION: Clean the cartridges or printhead only when necessary. Unnecessary cleaning wastes ink 
and shortens the life of the printhead.

7. Align the cartridges or printhead.

NOTE: Aligning the cartridges or printhead ensures high-quality output. The printer prompts you to 
align the cartridges or printhead every time you install a new cartridge. If you remove and reinstall the 
same cartridge, it will not prompt you to align as the printer remembers the alignment values for that 
cartridge.

To do this, you must:

● Load Letter, A4, or Legal unused plain white paper into the paper tray.

● Perform the alignment either using the printer software or the control panel.

To align the cartridges or printhead from the printer software (Windows)

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. In the printer software, click Print > Maintain Your Printer to access the printer toolbox window.

c. From the Device Services tab, click the option to align.

The printer prints an alignment sheet.

d. Follow the instructions on the printer screen to align the cartridges.

To align the cartridges or printhead from the printer software (OS X)

a. Open HP Utility.

NOTE: HP Utility is located in the HP folder in the Applications folder at the top level of the hard 
disk.

b. Select your printer from the Devices list.

c. Click Align and follow the onscreen instructions.

To align the cartridges or printhead from the printer control panel

a. On the printer control panel, from the Home screen, select Setup , and then press OK .

b. Select Tools, and then press OK .

c. Select the option to align, press OK , then follow the onscreen instructions.
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Network and connection issues
What do you want to do?

Fix wireless connection
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operating system. 

Use an HP online 
troubleshooting wizard

Troubleshoot a firewall or antivirus issue, if you suspect that it is preventing your computer from 
connecting to the printer.

● Troubleshoot your wireless problem, whether your printer has never been connected or it was 
connected and is no longer working.

● Troubleshoot a firewall or antivirus issue, if you suspect that it is preventing your computer from 
connecting to the printer.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for wireless troubleshooting

Check the network configuration or print the wireless test report to assist in diagnosing network connection 
issues.

1. From the printer control panel, from the Home screen, select Network, and then press OK .

2. Select Print Reports, and then press OK .

3. Select Configuration Page or Test Report, and then press OK .

Find network settings for wireless connection
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that can tell you the network name (SSID) and password 
(network key).

NOTE:  This utility is only available for Windows operating system. 

To check the wireless settings, open the HP Print and Scan Doctor, click the Network tab at the top, select 
Show Advanced Info, and then select Show Wireless Info. You can also find the wireless settings 
information by selecting Open router web page on the Network tab.

Use an HP online 
troubleshooting wizard

Learn how to find your network name (SSID) and wireless password.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Fix Wi-Fi Direct connection

Use an HP online troubleshooting wizard Troubleshoot your Wi-Fi Direct problem or learn how to configure Wi-Fi Direct.
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NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for Wi-Fi Direct troubleshooting

1. Check the printer to confirm that Wi-Fi Direct is turned on:

▲ From the printer control panel, from the Home screen, scroll down to select Wi-Fi Direct, and then 
press OK .

2. From your wireless computer or mobile device, turn on the Wi-Fi connection, and then search for and 
connect to the Wi-Fi Direct name of your printer.

3. Enter the Wi-Fi Direct password when prompted.

4. If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

Fix Ethernet connection
Check the following:

● The network is operational and the network hub, switch, or router is turned on.

● The Ethernet cable is plugged into the printer properly and the Ethernet light near the connector is 
turned on.

● Antivirus programs, including spyware protection programs, are not impacting your network connection 
to the printer. If you know that antivirus or firewall software is preventing your computer from 
connecting to the printer, use the HP online firewall troubleshooter to help solve the problem.

● HP Print and Scan Doctor

Run the HP Print and Scan Doctor to troubleshoot the issue automatically. The utility will try to diagnose 
and fix the issue. The HP Print and Scan Doctor may not be available in all languages.

Printer hardware issues
TIP:  Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and copying 
issues. The application is only available in some languages. 

The printer shuts down unexpectedly

● Check the power and power connections.

● Make sure the printer's power cord is connected firmly to a functioning power outlet.

Printhead alignment fails

● If the alignment process fails, make sure you have loaded unused, plain white paper into the input tray. 
If you have colored paper loaded in the input tray when you align the cartridges, the alignment fails.

● If the alignment process fails repeatedly, you may need to clean the printhead, or you might have a 
defective sensor. To clean the printhead, see Maintain the printhead and cartridges.

● If cleaning the printhead does not solve the problem, contact HP support. Go to www.support.hp.com . 
This website provides information and utilities that can help you correct many common printer 
problems. If prompted, select your country/region, and then click All HP Contacts for information on 
calling for technical support.
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Resolve printer failure

Complete the following steps to resolve such problems.

1. Press  (the Power button) to turn off the printer.

2. Unplug the power cord, and then plug in the power cord again.

3. Press  (the Power button) to turn on the printer.

If this problem persists, write down the error code provided in the message, and then contact HP support. For 
more information about contacting HP support, see HP support.

Get help from the printer control panel
You can use the printer’s help topics to learn more about the printer, and some help topics include animations 
that guide you through procedures, such as clearing jams.

To access the Help Menu from the Home screen or contextual help for a screen, press  (the Help button) 
on the printer control panel.

Understand printer reports
You can print the following reports to help troubleshoot problems with the printer.

● Printer status report

● Network configuration page

● Print quality report

● Wireless test report

Printer status report
Use the printer status report to view current printer information and cartridge status. Also use the printer 
status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.

If you need to call HP, it is often useful to print the printer status report before calling.

Network configuration page
If the printer is connected to a network, you can print a network configuration page to view the network 
settings for the printer and a list of networks detected by your printer. The last page of the report includes a 
list of all detectable wireless networks in the area, along with signal strength and the channels being used. 
This might help you select a channel for your network which is not heavily used by other networks (which will 
improve network performance).

You can use the network configuration page to help troubleshoot network connectivity problems. If you need 
to call HP, it is often useful to print this page before calling.

Print quality report
Print quality problems can have many causes-software settings, a poor image file, or the printing system 
itself. If you are unhappy with the quality of your prints, a Print Quality Diagnostic page can help you 
determine if the printing system is working correctly.
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Wireless test report
When you print the Wireless Test Report, a number of tests are run to check various conditions of the printer 
wireless connection. The report shows the results of the tests. If an issue is discovered, message along with 
how to fix it is provided at the top of the report. Some key wireless configuration details are provided at the 
bottom section of the report.

Solve problems using Web Services
If you are having problems using Web Services, such as HP ePrint , check the following:

● Make sure the printer is connected to the Internet using an Ethernet or wireless connection.

NOTE: You cannot use these web features if the printer is connected using a USB cable.

● Make sure the latest product updates have been installed on the printer.

● Make sure Web Services is enabled on the printer. For more information, see Set up Web Services.

● Make sure the network hub, switch, or router is turned on and working correctly.

● If you are connecting the printer using an Ethernet cable, make sure you are not using a phone cord or a 
crossover cable to connect the printer to the network, and that the Ethernet cable is securely connected 
to the printer. For more information, see Network and connection issues.

● If you are connecting the printer using a wireless connection, make sure the wireless network is 
functioning properly. For more information, see Network and connection issues.

● If you are using HP ePrint , check the following:

— Make sure the printer's email address is correct.

— Make sure that the printer's email address is the only address listed in the “To” line of the email 
message. If other email addresses are listed in the “To” line, the attachments you are sending 
might not print.

— Make sure you are sending documents that meet the HP ePrint requirements. For more 
information, visit HP Connected (This site might not be available in all countries/regions.).

● If your network uses proxy settings when connecting to the Internet, make sure the proxy settings you 
are entering are valid:

— Check the settings being used by the web browser you are using (such as Internet Explorer, Firefox, 
or Safari).

— Check with the IT administrator or person who set up your firewall.

If the proxy settings used by your firewall have changed, you must update these settings in either 
the printer control panel or the embedded web server. If these settings are not updated, you will 
not be able to use Web Services.

For more information, see Set up Web Services.

TIP: For additional help on setting up and using Web Services, visit HP Connected (This site might not be 
available in all countries/regions.).

Maintain the printer
What do you want to do?
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Clean the exterior 

WARNING! Before cleaning the printer, turn the printer off by pressing  (the Power button) and unplug the 
power cord from the electrical socket.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away from the 
interior of the printer, as well as from the printer control panel.

Maintain the printhead and cartridges
If you are experiencing problems with printing, you might have a problem with the printhead. You should 
perform the procedures in the following sections only when directed to do so for resolving print quality 
issues.

Performing the aligning and cleaning procedures unnecessarily can waste ink and shorten the life of the 
cartridges.

● Clean the printhead if your printed output is streaked or has any incorrect or missing colors.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and 
uses an increasing amount of ink. After each stage, review the quality of the printed page. You should 
only initiate the next phase of cleaning if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printer. If print 
quality problems persist after cleaning and aligning, contact HP support. For more information, see HP 
support.

● Align the printer when the printer status page shows streaking or white lines through any of the blocks 
of color, or if you are having print quality issues with your printouts.

The printer automatically aligns the printhead during the initial setup.

NOTE: Cleaning uses ink, so clean the printhead only when necessary. The cleaning process takes a few 
minutes. Some noise might be generated in the process.

Always use the power button to turn off the printer. Turning the printer off improperly can cause print quality 
problems.

To clean or align the cartridges or printhead

1. Load Letter, A4, or legal unused plain white paper into the input tray.

2. On the printer control panel, from the Home screen, select Setup , and then press OK .

3. Select Tools, and then press OK .

4. Select the desired option and then press OK . Then follow the onscreen instructions.

NOTE: You can also do the same from the HP printer software or embedded web server (EWS). To access the 
software or EWS, see Open the HP printer software (Windows) or Open the embedded web server.

Restore defaults and settings
If you disable some functions or change some settings and want to change them back, you can restore the 
printer to the original factory settings or network settings.
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To restore the printer to the original factory defaults

1. From the printer control panel, from the Home screen, select Setup , and then press OK .

2. Select Tools, and then press OK .

3. Select Restore, and then press OK .

4. A warning message appears which indicates all configured settings will be deleted and the original 
factory settings will be restored. Press the OK button to continue.

To restore the printer to the original network settings

1. From the printer control panel, from the Home screen, select Network, and then press OK .

2. Select Restore Network Settings, and then press OK .

A message appears stating that the network defaults will be restored.

3. Select Yes by pressing  (the Selection button).

4. Print the network configuration page and verify that the network settings have been reset.

NOTE: Previously configured wireless settings are removed when you reset the printer network settings.

TIP: You can visit the HP online support website at www.support.hp.com for information and utilities that 
can help you correct many common printer problems.

(Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and copying 
issues. The application is only available in some languages.

HP support
For the latest product updates and support information, visit the printer support website at 
www.support.hp.com . HP online support provides a variety of options for help with your printer:

Drivers & downloads: Download software drivers and updates, as well as product manuals and documentation 
that came in the box with your printer.

HP support forums: Visit HP Support Forums for answers to common questions and issues. You can view 
questions posted by other HP customers, or sign in and post your own questions and comments.

Troubleshooting: Use HP online tools to detect your printer and find recommended solutions.

Contact HP
If you need help from an HP technical support representative to solve a problem, visit the Contact Support 
website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted 
support for out-of warranty customers may require a fee):

Chat with an HP support agent online.

Call an HP support agent.
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When contacting HP support, be prepared to provide the following information:

● Product name (Located on the printer, such as HP OfficeJet Pro 8210)

● Product number (located near the cartridge access area)

● Serial number (located on the back or bottom of the printer)

Register printer
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and 
product support alerts. If you did not register your printer while installing the software, you can register now 
at http://www.register.hp.com.

Additional warranty options
Extended service plans are available for the printer at additional costs. Go to www.support.hp.com , select 
your country/region and language, then explore the extended warranty options available for your printer.
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A Technical information

This section contains the following topics:

● Specifications

● Regulatory information

● Environmental product stewardship program

Specifications
For more information, visit www.support.hp.com . Select your country or region. Click Product Support & 
Troubleshooting. Enter the name shown on the front of the printer, and then select Search. Click Product 
information, and then click Product specifications.

System requirements

● System requirements for Windows systems can be found in the Readme file, which is available on the HP 
printer software CD provided with your printer. System requirements for Mac OS X can be found at 
www.support.hp.com .

● For information about future operating system releases and support, visit the HP online support website 
at www.support.hp.com .

Environmental specifications

● Operating temperature: 5° to 40° C (41° to 104° F)

● Operating humidity: 15 to 80% RH non-condensing

● Recommended operating conditions: 15° to 32° C (59° to 90° F)

● Recommended relative humidity: 20 to 80% noncondensing

Input tray capacity

● Plain paper sheets (60 to 105 g/m2 [16 to 28 lb]): Up to 250

● Envelopes: Up to 30

● Index cards: Up to 50

● Photo paper sheets: Up to 50

Output tray capacity

● Plain paper sheets (60 to 105 g/m2 [16 to 28 lb]): Up to 150

● Envelopes: Up to 30

● Index cards: Up to 80

● Photo paper sheets: Up to 100
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Paper size and weights

For the list of supported paper sizes, see the HP printer software.

● Plain paper: 60 to 105 g/m2 (16 to 28 lb)

● Envelopes: 75 to 90 g/m2 (20 to 24 lb)

● Cards: Up to 200 g/m2 (110 lb index maximum)

● Photo paper: 300 g/m2 (80 lb)

Print specifications

● Print speeds vary according to the complexity of the document and printer model

● Method: drop-on-demand thermal officejet

● Language: PCL 6, PCL 5, PDF, PostScript

● Print resolution:

For a list of supported print resolutions, visit the printer support website.

● Print margins:

For margin settings of different media, visit the printer support website.

Cartridge yield

● Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory Model Number

● FCC statement

● VCCI (Class B) compliance statement for users in Japan

● Notice to users in Japan about the power cord

● Notice to users in Korea

● Noise emission statement for Germany

● European Union Regulatory Notice

— Products with wireless functionality

● Visual display workplaces statement for Germany

● Declaration of conformity

● Regulatory information for wireless products

— Exposure to radio frequency radiation

— Notice to users in Brazil

— Notice to users in Canada
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— Notice to users in Taiwan

— Notice to users in Mexico

— Notice to users in Japan

— Notice to users in Korea

Regulatory Model Number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory 
Model Number for your product is SNPRC-1603-01. This regulatory number should not be confused with the 
marketing name (HP OfficeJet Pro 8210 series) or product number (D9L63).

FCC statement
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VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Notice to users in Korea

Noise emission statement for Germany

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be 
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, 
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using 
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following 
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website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number 
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

HP GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

Products with wireless functionality

EMF

● This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.

If it incorporates a radio transmitting and receiving device that in normal use, a separation distance of 
20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

● This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein, 
Norway and Switzerland.

Visual display workplaces statement for Germany
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Declaration of conformity

78 Appendix A   Technical information ENWW



Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:

● Exposure to radio frequency radiation

● Notice to users in Brazil

● Notice to users in Canada

● Notice to users in Taiwan

● Notice to users in Mexico

● Notice to users in Japan

● Notice to users in Korea

Exposure to radio frequency radiation

Notice to users in Brazil
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Notice to users in Canada

Notice to users in Taiwan

80 Appendix A   Technical information ENWW



Notice to users in Mexico

Notice to users in Japan

Notice to users in Korea

Environmental product stewardship program
HP is committed to providing quality products in an environmentally sound manner. Design for recycling has 
been incorporated into this product. The number of materials has been kept to a minimum while ensuring 
proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and 
other connections are easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair. For more information, visit HP's Commitment 
to the Environment website at:

www.hp.com/hpinfo/globalcitizenship/environment

● Eco-Tips

● European Union Commission Regulation 1275/2008

● Paper 

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Power consumption

● Disposal of waste equipment by users

● Chemical substances

● Restriction of hazardous substance (Ukraine)

● Restriction of hazardous substance (India)

● China SEPA Eco Label User Information
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● China Energy Label for Printer, Fax and Copier

● The Table of Hazardous Substances/Elements and their Content (China)

● EPEAT

● Battery disposal in Taiwan

● California Perchlorate Material Notice

● EU Battery Directive

● Battery notice for Brazil

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. Please visit the HP 
Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

European Union Commission Regulation 1275/2008
For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P14 
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Paper
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and 
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources 
by reselling some of its most popular products. For more information regarding recycling of HP products, 
please visit:

www.hp.com/recycle

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in 
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more 
information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/
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Power consumption
HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. 
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging 
products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/energystar

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, 
you should protect human health and the environment by handing over your waste 
equipment to a designated collection point for the recycling of waste electrical and electronic 
equipment. For more information, please contact your household waste disposal service, or 
go to http://www.hp.com/recycle.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

Restriction of hazardous substance (Ukraine)

Restriction of hazardous substance (India)
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China SEPA Eco Label User Information

China Energy Label for Printer, Fax and Copier
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The Table of Hazardous Substances/Elements and their Content (China)

EPEAT

Battery disposal in Taiwan
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California Perchlorate Material Notice
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EU Battery Directive
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Battery notice for Brazil
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